
Important!

This is important so I am going to mention it again: There is currently No Undo Support 
in Times+! The Undo command is there simply for use by DA's under Mac OS 6. Please
remember this! You can always "undo" an action by reverting to a previously saved 
version of the open file. Save often, as this is your only recourse should you perform an 
action you wish to undo!

Opening Times+

When you first open Times+ it creates a new, untitled and unsaved Event List and 
opens the Main window. If you double-click on a Times+ file, it will open that file rather 
than create a new one. If you open multiple Times+ files from the Finder it will only open
the first it receives from the Finder. If you try to print one or more Times+ files from the 
Finder, it will open Times+ but nothing will happen because printing is not yet supported.

Creating, Editing, & Deleting Events

Before you can time something with Times+, you must create an Event to time.

This can be accomplished two ways. With the Main window in front:
1) Click on the card icon labeled “New” in the Main window. Or…
2) Select “New Event…” (command-N) from the Control menu.

In either case a dialog comes up which allows you to enter the Event Title and ID#. Click
Cancel to cancel the operation. Click New to create a new Event with the given Title and
ID#.

You can enter any characters in either field. The ID# doesn’t have to be a number at all. 
It’s there entirely for your use. There’s no length limit on either field although you should 
probably keep things down to 30-40 characters or so. Also, you could enter nothing in 
either or both fields, but that would be rather confusing. The Events are listed 
alphabetically by Title. Duplicates are allowed although, again, that may be confusing.

If you make a mistake, or later want to change the Title or ID#, you may edit any Event 
by selecting the Event you wish to edit in the Event List, and:
1) Click the card icon labeled “Edit” in the Main window. Or…
2) Select “Edit Event…” (command-E) from the Control menu. Or…
3) Double-click the Event in the Event List.

A dialog will come up with the current Title and ID# of the Event filled in. You may edit 



them to your liking. Clicking Cancel will cancel the operation and leave the Event as is. 
Clicking Edit will edit the Event, giving it the new Title and ID# you have entered.

You may delete an Event at any time. Select the Event or Events which you wish to 
delete in the Event List and:
1) Click on the trash can icon labeled “Delete” in the Main window. Or…
2) Select “Delete Event” from the Control menu.

Times+ will ask you if you really want to delete the Event or Events, as Undo is not yet 
supported. Clicking Cancel will leave the Events. Clicking Delete will Delete them. 
Please be careful as you cannot recover them with the Undo command!

Timing Events

Once you have created an Event, you may begin timing it and alternately pause and 
resume the timing. You may also reset the timing.

To start or resume timing for an Event or Events, select the Event or Events you wish to 
start/resume in the Event List and:
1) Click the play icon labeled “Start” in the Main window. Or…
2) Select “Start Timer” (command-T) from the Control menu.

Times+ will make a starting Entry for the Event, or an Entry for each Event, and begin 
displaying the timing information if a single Event is selected. Select any single Event to 
view this information.

To stop or pause timing for an Event or Events, select the Event or Events you wish to 
stop/pause in the Event List and:
1) Click the stop icon labeled “Stop” in the Main window. Or…
2) Select “Stop Timer” (command-shift-T) from the Control menu.

Times+ will make a stop Entry for the Event, or an Entry for each Event, and update the 
display if a single Event is selected. Select any single Event to verify that they have 
indeed stopped.

Start will do nothing to Events which are already running, as Stop will do nothing to 
Events which are already paused. You may start and stop timing repeatedly as often as 
you like. The Event continues from where it last was in terms of total time.

Note that multiple Events may be running simultaneously. But, in order to preserve the 
timing after quitting the application or opening another Event List, you must save the 
current Event List, which is described later on.

To reset the Time Record (total time) for an Event or Events, select the Event or Events 
which you wish to reset in the Event List and:



1) Click the X icon labeled “Reset” in the Main window. Or…
2) Select “Reset Timer” from the Control menu.

Times+ will ask you if you really want to reset the selected Events. Clicking Cancel 
cancels the operation and leaves the Events as they were. Clicking Reset will reset all 
of the Events selected, whether they are running or not. Please be careful as this 
cannot be undone in this version!

Event Notes

You may enter and edit notes for each Event at any time by selecting the Event you 
wish to enter notes for, by itself, in the Event List and simply typing in the “Event Notes” 
field. Notes will only be preserved if a single Event is selected. If more than one, or no, 
Events are selected, the text you enter will not be preserved. You may enter up to 32K 
of text for each Event. Please note that this field makes use of the Macintosh OS text 
engine, which is designed for small amounts of text. This engine can slow down at 
around 3K or 4K, even though it is capable of storing up to 32K. Users with faster 
machines may not notice.

Viewing the Time Record

You may view the Time Record of any Event by selecting the Event or Events which you
wish to view and:
1) Select “View Time Record” from the Control menu.

A generic scrolling text window will open with the Time Records converted to text and 
displayed. First the Event information is shown, including notes, and then each Entry, 
and then another Event and its Entries for each Event selected. The window is modal.

Please note that this window can only display up to 32K of text. If you select many 
Events with many Entries, or Events with long Notes, the window may not be able to 
display them all. Select fewer at a time to see them.

You may cut and copy text from this window. Actually, you can fully edit the text. Nothing
will be affected. This is only a text copy of the Event information for viewing. Any editing 
you perform will be lost as soon as you close the window. 

Daylight Savings Time

Because Times+ depends on the Mac’s clock for timing, any change in the clock will 
cause an inaccuracy in Events which are running while the change is made. This 
creates a problem for those who live in areas which use Daylight Savings Time (DST).



To compensate, a command is included to add or subtract one hour from selected 
Events. This only needs to be done for those Events which were running at the time that
you actually changed your Mac’s clock, whether the Event List was open or not. Paused
Events are unaffected.

To compensate for DST, select the Event or Events which were running at the time you 
changed your Mac’s clock and:
1) Select “Daylight Savings…” from the Control menu.

A dialog will appear asking whether you wish to compensate for Fall or Spring. Clicking 
Cancel will leave the Events as they were. Clicking Fall will add an Entry with one hour 
to each selected Event. Clicking Spring will add an Entry with minus one hour to each 
selected Event. 

When viewing Time Records, these Entries will be numbered -1 and will have nonsense
date/time stamps. All that’s important in this case is the total Entry time, -1 hour or +1 
hour. You may compensate repeatedly for an Event.

Using MiniViews

You may display a MiniView window for an Event at any time by selecting the Event or 
Events for which you want a MiniView window and:
1) Clicking the window icon labeled “Mini” in the Main window. Or…
2) Clicking the box with arrows icon labeled “Collapse” in the Main window. Or…
3) Selecting “MiniView” (command-M) from the Window menu.

MiniViews for each selected Event will open and come to the front. If you used option 2, 
the Collapse icon, the Main window will close after the MiniViews have opened. You 
may open it back up and bring it to front at any time by selecting “Full View” (command-
F) from the Control menu.

If the Event already has an open MiniView, that window will come to front if the Event is 
selected and you do any of the above. There may only be one MiniView per Event.

Each MiniView window displays the Event Title and Total Time. In addition, MiniViews 
have the timing icons of the Main window. Clicking them starts, stops, or resets only the 
Event displayed in the MiniView. The window icon in each MiniView does something a 
little different from the same icon in the Main window: it opens the Main window and 
brings it to front.

The Start Timer, Stop Timer, and Reset Timer commands in the Control menu actually 
apply to the currently front window. If it’s the Main window, they apply to any and all 
selected Events. If a MiniView is in front, they apply to the Event of the MiniView.

MiniViews may be “collapsed” to a smaller version by simply clicking the resize box in 



the upper right corner of the window.

Dealing With Event List Files

PLEASE NOTE: An Event List is the file which holds any and all Events which you have 
created for that particular list and their information. For running Events to continue being
timed (and other Events to be preserved) after you have closed the file, quit Times+, or 
shutdown your computer, YOU MUST HAVE SAVED the Event List which they were in.

You may create a new Event List at any time by selecting “New” (option-command-N) 
from the File menu. Times+ will ask you if you wish to save changes to the current 
Event List. Clicking Cancel will cancel everything and leave the current Event list as it is.
Clicking Discard will create a new Event List without saving the old. Clicking Save will 
save the Event List, or invoke Save As if it has never been saved, and then create a 
new Event List.

You may open a previously saved Event List at any time by selecting “Open…” 
(command-O), which shows the standard Macintosh file dialog letting you open another 
Event List. Since only one may be open at a time this implicitly closes the current file. 
Times+ will ask you to save changes first, much like when creating a New file.

“Close” (command-W) under the File menu simply closes the front window, but does not
close the Event List file.

You may save an Event List at any time by selecting “Save” (command-S) from the File 
menu. If you have already saved the file, this will simply re-save it to the same location 
and under the same name. If you are saving a file for the first time, this will 
automatically invoke “Save As…” (option-command-S). This will present you with the 
standard Macintosh file dialog from which you may choose the location and name of the
file to be saved. Clicking Save saves the file, while clicking Cancel cancels the 
operation. Save after any changes to the Events (creating, starting or stopping, editing, 
changing the notes, etc.) to preserve your actions.

“Save As…” (command-option-S) lets you re-save the currently open Event List under a 
new name and in a new location. It presents you with the standard Macintosh file dialog.

“Rename…” lets you give a new name to the currently open Event List if it has been 
saved to disk.

“Delete” deletes the current Event List from disk but leaves it open in RAM to be saved 
again. Times+ will ask you to confirm this action before deleting the file.

You may export Events with their Time Records and information (Title, ID#, Notes) to 
disk as text for formatting and printing from a word processor. First, select the Events 
which you wish to export from the Event List in the Main window. Then select “Export 



To…” (shift-command-E) from the File menu. Times+ will build a text file with their 
information and let you save it using the standard Macintosh file dialog.

You may merge two Event Lists at any time. Open the first Event List to be merged just 
as you would open any file (Open command). Then select “Merge List With…” under the
File menu. You will be asked if you wish to save the current Event List. Do so if you 
want to preserve it as it is. You will be presented with the standard Macintosh file dialog 
from which you may select the second list to be merged with the currently open list. 
Times+ will then create a new Event List with the Events from both lists. You may then 
save this new list or do anything else with it just as normal.

And, of course, “Quit” (command-Q) quits Times+.

About Times+

You may view the About dialog for Times+ at any time by selecting “About Times+ 
1.1…” from the Apple menu, or clicking the word balloon icon labeled “About” in the 
Main window. Clicking OK in the dialog dismisses it.


